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1. Introduction to Kernel for Notes Contacts to 

Outlook 

Welcome to the user manual of Kernel for Notes Contacts to Outlook, the most powerful, professional and 
easy to use notes address book migration software that helps you to convert contact items from 
Names.nsf file to .PST or .XLS file. It also converts names.nsf file direct from Lotus Domino Server 
mailboxes. This user manual comprises step by step guidelines on using Kernel for Notes Contacts to 
Outlook. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for Notes Contacts to Outlook. We suggest 
that first time users should read this user manual completely and carefully before proceeding to use the 
software. However, if you are an experienced user, you can use the table of contents to find out 
information pertaining to the tasks that you need to perform by using Kernel for Notes Contacts to Outlook. 

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 How to convert Names.nsf file? 

 Saving converted files 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 

NSF: Notes System File 
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XLS: Excel sheet 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 

1.2 About Kernel for Notes Contacts to Outlook 

Kernel for Notes Contacts to Outlook is a Lotus Notes Contacts migration tool to migrate/export Notes 
Contacts to MS Excel and MS Outlook. Easily export contacts of Lotus Notes to MS Outlook and MS 
Excel. 100s and 1000s of contact list from Names.nsf file(s) are easy to export to .PST and .XLS and 
viewable with MS Outlook and MS Excel. Several Names.NSF files can be listed and exported to Microsoft 
Outlook or Microsoft Excel. 

Kernel software supports migration of names.nsf file created with Lotus Notes client 6.5, 7.0, 8.0 in 
Domino Server 6.5, 7.0, 8.0. Kernel for Notes Contacts to Outlook directly gets connected to the Lotus 
Domino Server user mailbox and lets the user select and convert Names.nsf file. Useful for 
Organizations/Companies/Individuals who need to export their notes contacts to other viewable medium 
like MS Outlook Contacts or MS Excel worksheet. 

1.3 Salient Features 

Salient features of Kernel for Notes Contacts to Outlook include: 

 Efficient and embedded with algorithms to quickly perform conversion process 

 Fully supportive to versions including: Lotus Notes 8.0, 7.0 and 6.5, MS Outlook 97, 98, 2000, 2003, 
2007 and Lotus Notes, Lotus Domino Server 8.0, 7.0 and 6.5. 

 User friendly graphical user interface 

 Free demo to analyze capabilities of the tool before purchasing it 

1.4 Who Should Use this Software? 

The capability of Kernel for Notes Contacts to Outlook to convert Names.NSF files makes it an apt choice 
for organizations that need to migrate from Lotus Notes to Outlook. Kernel for Notes Contacts to Outlook - 
names.nsf file conversion tool uses quick algorithm to convert names.nsf files to .PST or .XLS files hence, 
organizations with instant Notes Contacts to Outlook migration requirements can use this software. 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for Notes Contacts to Outlook, you are 
ready to get hands on experience of the software. To start migration process, you will first need to 
download and install this software. 

It is strongly recommended that before installing Kernel for Notes Contacts to Outlook, you should go 
through the installation pre-requisites for the software to ensure that your computer is appropriately 
configured to run the software. 

2.1 Installation Pre-requisites 

Kernel for Notes Contacts to Outlook- names.nsf file conversion tool works on all Windows-based 
computers. Following are the system requirements for the host Computer: 

2.1.1 To Convert from NSF file 

 Supported Lotus Notes Version: Lotus Notes 8.0, 7.0 and 6.5 

 Supported MS Outlook Versions: MS Outlook 97, 98, 2000, 2003 and 2007 

 Supported MS Excel: MS Excel 97, 98, 2000, 2003 and 2007 

@ Note: Microsoft Outlook, Microsoft Excel and Lotus Notes should be installed on the 
computer system on which you are performing the conversion. 

2.1.2 To convert from Domino Server Mailbox 

 Supported Domino Server: Domino Server 8.0, 7.0 and 6.5 

 Supported Lotus Notes Version: Lotus Notes 8.0, 7.0 and 6.5 

 Supported MS Excel Versions: MS Excel 97, 98, 2000, 2003 and 2007 

 Supported MS Outlook Versions: MS Outlook 97, 98, 2000, 2003, 2007 

2.1.3 Other Requirements 

Supported Operating System 

Windows Vista, Windows 2003, Windows 2000, Windows XP and Windows 98 

Memory (RAM) 

At least 64 megabytes (the more the better) 

CPU Processor 
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Pentium II 400 MHz 

Available Space on the Good Device 

Enough space to save the converted file(s) for example, if you expect to save 40 MB lost data, the Good 
Device should have at least 40 MB free space 

2.2 Downloading Kernel for Notes Contacts to Outlook for the First 
Time 

After checking your computer with the prescribed system requirements for Kernel for Notes Contacts to 
Outlook, you can download and install the software on your computer. You can buy the full version of the 
software from any one of our authorized resellers ï Element5, Asknet and 2CO. 

If you want to try using Kernel for Notes Contacts to Outlook before buying it, you can download the 
evaluation version from the following link: 

http://www.nucleustechnologies.com/download-notes-contacts-to-outlook.php 

2.3 Install Kernel for Notes Contacts to Outlook 

After downloading the installer file for Kernel for Notes Contacts to Outlook, you can install the software by 
running the file. 

To install Kernel for Notes Contacts to Outlook: 

1. Double-click the Kernel for Notes Contacts to Outlook installer. Follow the on-screen instructions. 

The Setup Installation Complete screen will be displayed. 

2. Click Finish to launch the software. 

2.4 Start Kernel for Notes Contacts to Outlook 

To start Kernel for Notes Contacts to Outlook: 

Click Start Ą All Programs ĄKernel for Notes Contacts to Outlook 

Alternatively, you can launch Kernel for Notes Contacts to Outlook by double-clicking the shortcut icon 
available on the Desktop and Quick Launch icon. 

2.5 Uninstall Kernel for Notes Contacts to Outlook 

You may need to uninstall Kernel for Notes Contacts to Outlook. To uninstall Kernel for Notes Contacts to 
Outlook: 

1. Click Start Ą All Programs ĄKernel for Notes Contacts to Outlook Ą Uninstall Kernel for Notes 
Contacts to Outlook 

A warning message will be displayed. 

http://www.nucleustechnologies.com/download-notes-contacts-to-outlook.php
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2. Click Yes to uninstall Kernel for Notes Contacts to Outlook. 

@ Before proceeding to uninstall Kernel for Notes Contacts to Outlook, you must 
ensure that the software is not running on your computer. 

You can alternatively uninstall Kernel for Notes Contacts to Outlook from the Control Panel by performing 
the following steps: 

1. Click the Start Menu Ą Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for Notes Contacts to Outlook and click Remove. 

A warning message will be displayed. 

3. Click Yes to uninstall Kernel for Notes Contacts to Outlook. 
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3. Software Interface 

Now that Kernel for Notes Contacts to Outlook has been installed on your computer, you can start using 
the software after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Notes Contacts to Outlook comprises two main menus ï File, and Help. 

3.1.1 File Menu 

The File menu comprises four menu items. 

 
Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Add File(s) Opens the Open window 

Add Domino File(s) Opens the Domino Server file selection window 

Export Opens the Save Option window 

Exit Closes the software 

3.1.2 Help Menu 

 
Figure 3.2: Help Menu 

Menu items in the Help menu: 
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Field Name Field Description 

Help Displays information pertaining to performing various 
tasks using Kernel for Notes Contacts to Outlook 

Software Homepage Visit software homepage on our website 

About Kernel for Notes 
Contacts to Outlook 

Displays version-related and support information of 
Kernel for Notes Contacts to Outlook 

3.2 Tool-bar 

Read the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Add File(s) Opens the óOpenô Window for listing the 
names.nsf file for conversion 

 

Add Domino File(s) Opens the Domino Server file selection window 

 

Export Opens the Save Option window 

 

Help Displays the version- and support related 
information of Kernel for Notes Contacts to 
Outlook 

 

Buy Online Purchase the Software from website 

3.3 Status Bar 

Status bar is displayed at the bottom of the software window. The text ówww.nucleustechnologies.comô is 
displayed on the status bar when you open the software. This text changes according to the actions which 
are performed with the tool bar buttons The Status bar also displays the text óCAPô, óNUMô, óSCRLô which 
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respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your keyboard. If any of 
these keys are pressed, the color of the corresponding text will turn blue/black. 

 

Figure 3.3: Status Bar 

3.4 Customize User Interface 

You can add or remove toolbar buttons by clicking: 

ĄAdd or Remove ButtonsĄStandard in the toolbar and selecting appropriate buttons. 

  



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

4. How to Convert Names.NSF files? 

4.1 Converting Names.NSF file 

Now that you have complete familiarity of the user interface of Kernel for Notes Contacts to Outlook, you 
are ready to convert Names.NSF files. 

To convert Names.NSF files: 

1. Launch Kernel for Notes Contacts to Outlook. 

 

Figure 4.1: Main Window- Kernel for Notes Contacts to Outlook  

2. Click the Add Files. Open window will appear to select the Name.NSF file. 
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Figure 4.2: Select NSF File  

3. Select the Name.NSF file. 

4. Click OK to list the file in Kernel software. 

 

Figure 4.3: Selected NSF Files  
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5. Click Preview to view preview of the file contents before saving them or click Export to save the 
converted items in .PST or .XLS file. 

 

Figure 4.4: Preview of the File Content  

6. When you click Preview, Kernel software displays preview of the converted contacts in two categories: 
My Contacts and By Category. The right pane displays the alphabetical and numeric filter options, 
where you can view the contacts details of specific user by filtering his name first alphabet. Click the 
alphabet, numeric value or the categories to view preview of the contact details before saving them. 

7. When you click Export button the software provides you with two saving options: 

 Save in PST: Saves the calendar entries to new or existing PST file 

 Save in Excel File: Saves the calendar entries to new .XLS file 
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Figure 4.5: Select Saving Option 

8. Export contacts to the desired file and the Names.NSF file will be converted. 

4.2 Converting Names.NSF file from Lotus Domino Server Mailboxes 

Kernel for Notes Contacts to Outlook software enables the administrators to convert the names.nsf file 
directly from the Lotus Domino Server. Access the Domino server with the help of Kernel software and 
convert the notes contacts to Outlook or Excel file by following these simple steps: 

1. Launch Kernel for Notes Contacts to Outlook software. 

2. Click Add Domino File(s). Domino Server File Selection Window will appear to define the Domino 
Server settings. 
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Figure 4.6: Domino Server File Selection Window  

3. Click Add Domino Server to define the Domino Server name. If you want to search for Domino 

Servers that are available on the network, click Search Domino Server. 

4. Kernel software asks for the ID file password to access the Domino server user mailbox. Type the 
password and click OK. 
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Figure 4.7: Search for Domino Server  

5. Now all available Domino servers will get listed. Select the Domino server name from the list. 
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Figure 4.8: Available Domino Server  

6. Select the Names.NSF file(s) and click Add. 

7. Selected file(s) will get listed in Kernel software. Click Finish to close the window. 

8. Select the file you want to save and click Export. 
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Figure 4.9: Select File to Export  

9. When you click Export button the software provides you with two saving options: 
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Figure 4.10: Saving Options  

 Save in PST: Saves the calendar entries to new or existing PST file 

 Save in Excel File: Saves the calendar entries to new .XLS file 

10. Export Domino Server Mailboxes to the desired file. 
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5. Saving Converted Files 

5.1 Save in Excel 

To save the converted file in Excel, follow these simple steps: 

1. Click Save in Excel File radio button. Define the Excel file path location where you want to save 
the file on your hard drive. 

2. Name the Excel file and click OK. Kernel for Notes Contacts to Outlook will start the saving 
process. 

3. Once saving process is complete, a message will be displayed. Click OK. 

5.2 Save in PST 

To save the converted file in PST, follow these steps: 

1. Click Save in PST File radio button. In Save Options Window, define the PST file setting. To 
define PST file setting two options will appear i.e. Save in a New File and Save in Existing File. 

2. If you want to save the converted items in any new PST file, define: PST Folder Path: The PST file 
path location where you want to save the file on your hard drive. PST File Name: The name of the 
PST files which you are saving. 

3. If you want to save the converted items in any existing PST file, define PST file location where you 
want to save the converted file. 

4. Click OK and the saving process will start. Once the saving process is complete, a message will 
appear. Click OK. 
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6. Full Version 

Although you can use Kernel for Notes Contacts to Outlook evaluation version for free and experience the 
capabilities of the software but there are certain features that are not available in the evaluation version. 

6.1 Requirement of Full Version 

The free to evaluate demo version of Kernel for Notes Contacts to Outlook software is fully functional in its 
conversion capabilities. It will convert your names.nsf files to .PST file and .XLS and will show preview of 
the converted contacts with data. But due to demo limitations it allow you to convert only single 
Names.NSF file and save first five contacts existing in the NSF file. 

You will need to buy the full version of the software to save desired Names.NSF files. 

6.2 Purchasing Full Version 

You can buy the full version of Kernel for Notes Contacts to Outlook from any one of our authorized 
resellers ï Element5, Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for Notes Contacts to Outlook and activation 
details of the software. 
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7. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Notes Contacts to Outlook. The software comes with an embedded help manual that 
can be accessed by clicking HelpĄ Help in the menu-bar. You can also press the F1 key on the keyboard 
of your computer to access the embedded help of Kernel for Notes Contacts to Outlook. 

You can access the online help for Kernel for Notes Contacts to Outlook at 
http://www.nucleustechnologies.com/Online-Helps.html 

We also have live support wherein you can chat with our software experts at 
http://www.nucleustechnologies.com/Support.html 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
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mailto:sales@nucleustechnologies.com
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8. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for Notes Contacts to 
Outlook. 

8.1 Common Issues 

Why does Kernel for Notes Contacts to Outlook have limitations in evaluation copy? 

The free evaluation version of Kernel for Notes Contacts to Outlook is intended to enable you to 
experience the capabilities of the software. With demo version of the software, you can convert contact 
addresses of single .nsf file and save only first five contacts per folder which exists in the .nsf file. You will 
need to buy the software to perform complete conversion and saving. 

8.2 Frequently Asked Questions 

How to Buy Kernel for Notes Contacts to Outlook? 

You can buy Kernel for Notes Contacts to Outlook online at http://www.nucleustechnologies.com/Buy-
Data-Recovery-Software.html 

I have lost my full version for Kernel for Notes Contacts to Outlook. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 
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9. Legal Notices 

This section comprises the legal specification about Kernel for Notes Contacts to Outlook and the 
company NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

9.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

9.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS and Open Office 
are registered trademarks of Microsoft Corporation and Sun Microsystems, Inc. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

9.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

9.4 License Agreement 

Kernel for Notes Contacts to Outlook Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 
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each Licensed Copy of Kernel for Notes Contacts to Outlook. For purposes of this License, if you have a 
valid license, you have the right to use a single Licensed Copy of Nucleus Kernel. 

Scope of License 

Each Licensed Copy of Kernel for Notes Contacts to Outlook may either be used by a single person or 
used non-simultaneously by multiple people who use the software personally installed on a single 
workstation. All rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are 
entirely and exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You 
may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative 
works based on, Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus 
Kernel available to others in connection with a service bureau, application service provider, or similar 
business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Notes Contacts to Outlook, and any and all accompanying software, files, data and materials, 
are distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential part 
of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
authorize you or anyone else to use Kernel for Notes Contacts to Outlook in applications or systems 
where Kernel for Notes Contacts to Outlook failure to perform can reasonably be expected to result in a 
significant physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold 
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless from any and all claims or losses 
relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 

Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


